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This document is intended to help new or existing developers quickly start evaluating the EVK and using SDK to 
develop Wi-Fi and Bluetooth LE applications with the RA6W2 chipset.
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1.    Terms and Definitions
AP Access Point
API Application Program Interface  
Arm Advanced Risc Machine
Bluetooth LE Bluetooth® Low Energy

COM Communication Port
CPU Central Processing Unit
DPM Dynamic Power Management
GDB GNU Debugger
EVK Evaluation Kit
FSP Flexible Software Package
GCC GNU Compiler Collection
GPIO General-Purpose Input/Output
IDE Integrated Development Environment
IC Integrated Circuit
MCU Micro Controller Unit
PMGR Power Manager
PXP Proximity Profile
QSPI Quad Serial Peripheral Interface
RAM Random Access Memory
ROM Read Only Memory
RTC Real Time Clock
RTOS Real Time Operating System
RX Receive
SD Secure Digital
SDK Software Development Kit
SMA SubMiniature Version A
SoC System on Chip
SPI Serial Peripheral Interface
SPS Serial Port Service
TX Transmit
UART Universal Asynchronous Receiver/Transmitter
UDP User Datagram Protocol
WLCSP Wafer Level Chip Scale Package
WSL Windows Subsystem for Linux
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2.    Overview
RA6W2 is a highly integrated ultra-low-power Wi-Fi plus Bluetooth® Low Energy (Bluetooth LE) Combo system in a 
package that allows you to develop Wi - Fi and Bluetooth LE solutions using a single chip. This Getting Started Guide 
provides an overview of setting up the RA6W2 EVK, Programming the released SDK images, instructions for 
importing and building images with the sample project template using e2 studio Integrated Development Environment 
(IDE).
The following are the quick guidelines to start using EVK:
 n RA6W2 EVK hardware (see Section Section 3 Evaluation Kit).
 n Setting up the evaluation board (see Section 4 Set Up RA6W2 EVK).
 n Programming firmware image (see Section 4.1 Firmware Image Programming).
 n Configuring EK-RA6W2 Serial Debug Interface (see Section 4.2 EK-RA6W2 Serial Debug Interface Configuration).
 n Provisioning Wi-Fi (see Section 4.3 Provision Wi-Fi).
 n Evaluating throughput with iPerf (see Section 5.1 Test Throughput with iPerf Traffic Generator).
 n Measuring current consumption (see Section 5.2 Measure Current Consumption).
 n Software development kit and build setup (see Section 6 Software Development Kit and Build Setup).
For more resources, go to:
 n RA6W2 product page – documentation, example projects. 
 n EK-RA6W1 board page (https://www.renesas.com/en/design-resources/boards-kits/ek-ra6w1).

https://www.renesas.com/en/design-resources/boards-kits/ek-ra6w1
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3.    Evaluation Kit
The RA6W2 evaluation kit (EVK) is designed to test and develop Wi-Fi applications quickly. The EVK is provided to 
simplify the process of starting a project with the RA6W2.
The EVK contains:
 n Evaluation kit (EVK): The board is made by a mother board with debugging and power measurement circuitry and a 

daughter board containing the RA6W2 and related needed circuitry.
 n USB cable.

3.1  EK-RA6W2
Figure 1 shows the hardware configuration of the RA6W2 EVK and Table 1 shows EK-RA6W2 components and 
descriptions.

Figure 1. EK-RA6W2 hardware configuration
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Table 1. Components on EK-RA6W2
No Name Description
1 USB302 – USB port Provides power and data port for the RA6W2 EK.

2 U301 – USB HUB Connects JTAG and UART interfaces to the PC.

3 J201/J203 – 
Signal/Power breakout 
headers

Exposes all the pins of the Daughterboard and Motherboard to allow wiring for custom 
configurations as well as monitoring of the hardware signals. See Figure 2 and Figure 3.

4 U201- daughterboard 
connector

The interface mating connector for the Daughterboard.

5 J206/J207/J215/J216 - 
Arduino sockets

The sockets for plugging in Arduino interface add-on boards. See Figure 9.

6 J208/J209 - 
MikroBUS™ sockets

Sockets for plugging in MikroBUS™ interface add-on boards. It is multiplexed with PMOD (to be 
used with DA1453x). See Figure 13.

7 J219 - PMOD 
connectors

The socket for plugging in PMOD interface add-on boards. J319 is a header, No mounted. J219 and 
J319 share some signals which are multiplexed with MikroBUS™. See Figure 5.

8 J607 - Push-buttons J607 push-button used to reset Daughterboard, J608/J609/J610 push buttons for general use. See 
Figure 11.

9 J2/J102 - Power 
selection

The current sense circuit option. Using this current measurement circuit, you can monitor the current 
consumption of Daughterboard through Smart Snippets Toolbox software application.

10 J105/J106/J107 - I/O 
voltage selection

Selects the I/O voltage applied to the Daughterboard (1.8 V, 3.3 V).

11 U503 - Current sense The current sense circuit.

12 J3 - SPI interface 
switch

Selects the I/O voltage generated for the Daughterboard board (1.8 V, 3.3 V). See Figure 14.

13 U302 - USB interface 
IC

Provides communication between Daughterboard UART port and PC. It also transfers the current 
measurement samples to PC.

14 U7 - Level translators Transfers the data between Daughterboard and FTDI (U302) in proper voltage level.

15 J405 - External J-link 
connector

Provides access toWi-Fi SoC or Bluetooth LE SoC. See Figure 6.

16 U401 – MCU Place where the SWD implementation of SEGGER applied.

17 J220 - SDIO header Must be mounted.

18 J601 – Trigger The trigger signals monitored and presented on Smart Snippets Toolbox. See Figure 12.

19 U2/U6/U8/U9 - Level 
translators

For the interface section (PMOD, Android and MikroBUS).

20 J611 – LEDs Four LEDs are connected to this header. To enable an LED, a jumper wire must be connected 
between a GPIO and one of the pins of J611.

21 U202 - PSRAM PSRAM. See Figure 4.

22 J6 – AIN GND AIN is a generic Analog Input which is accessible on J6 header.

23 Daughterboard  

Figure 15 shows the hardware configuration of the daughterboard of the RA6W2 EVK.
NOTE
Renesas Electronics  recommends using a daughterboard with an antenna.
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Figure 2. Breakout Header J201

Figure 3. Breakout Header J203
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Figure 4. PSRAM

Figure 5. PMOD0

Figure 6. External J-Link connector
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Figure 7. Auxiliary UART

Figure 8. Programming RA4M2
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Figure 9. Arduino Interface
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Figure 10. Daughter_Board Connector
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Figure 11. Buttons

Figure 12. Trigger
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Figure 13. Micro BUS

Figure 14. J3

Figure 15. RA6W2 daughterboard
Table 2 shows the components of EK-RA6W2 daughterboard.
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Table 2. EK-RA6W2 daughterboard components
No Name Description
1 U105 – RA6W2 RA6W2 – WLCSP

2 U102 – Serial Flash Serial Flash – AT25SL641

3 Y101 – Crystal 40 MHz crystal

4 Y102 – Crystal 32.768 kHz crystal

5 Y201 – Crystal 32 MHz crystal

6 SW202 – RF switch RF switch for Wi-Fi and Bluetooth LE

7 J101 – SMA connector SMA connector for external antenna

8 J201 – Reset switch Switch to reset the RA6W2

9 J205 – Headers RF switch control signal/Bluetooth LE signal breakout headers
(see Figure 16).

Figure 16. Breakout header J205 – daughterboard
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4.    Set Up RA6W2 EVK
Before setting up ensure that the Evaluation Kit (EVK) and the required software are properly connected and installed. 
Use the USB cable included in the EVK to connect the host computer and the EVK. When the EVK is connected to the 
USB port (USB302 on the RA6W2 EVK) USB Serial COM ports are created.
 n For Windows, three USB Serial COM ports are displayed in the device manager (see Figure 17).

Figure 17. Windows – COM ports
NOTE
If Windows Device Manager displays Unknown Device, the FTDI serial driver is not installed. Download the driver by following 
the URL and installing it manually: http://www.ftdichip.com/Drivers/.

The lower numbered J-Link CDC UART Port (COM7, in this case) is the onboard J-Link. The next USB Serial Port 
(COM8, in this case) is for the RA6W2 debug interface. The higher numbered USB Serial Port (COM9, in this case) is 
for the RA6W2 AT command interface or current consumption measurement. A serial terminal application can be used 
for debugging RA6W2.
The Tera Term terminal emulator program is recommended and can be downloaded from 
https://github.com/TeraTermProject/teraterm/releases/tag/v5.2.
 n For Linux, two Serial COM ports are created. It can be checked using the following command in Terminal.

developer:~$ ls /dev/ttyUSB*
developer:~$ /dev/ttyUSB0 /dev/ttyUSB1

The lower numbered USB Serial Port (/dev/ttyUSB0, in this case) is for the RA6W2 debug interface. The higher 
numbered USB Serial Port (/dev/ttyUSB1, in this case) is for the RA6W2 AT command interface or current 
consumption measurement. A serial terminal application can be used for debugging RA6W2.
Minicom is recommended for Linux and to install minicom on Linux, run this command:

developer:~$ sudo apt-get install minicom

When the terminal emulation application is installed, connect the USB cable to USB302 on the RA6W2 EVK and start 
the terminal emulation program. In the terminal emulation program, go to the Serial Port setup and select the preferred 
COM Port.

4.1  Firmware Image Programming
4.1.1    Program Firmware Images for Windows
Programming firmware images to the EVK requires the Renesas Flash Programmer(RFP) tool. The RFP provides a 
graphical interface to flash binary images into the RA6W2 EVK through the on-chip debug interface.
System requirements:
 n OS: Windows 11 (64 bit)
 n USB drivers (installed along with RFP setup)
 n Renesas Flash Programmer V3.22.00 or later
 n Hardware: RA6W2 EVK.
To program firmware:
 1. Download and launch the Renesas Flash Programmer installer,
 2. In the Software License Agreement select Agree and click Next.

http://www.ftdichip.com/Drivers/
https://github.com/TeraTermProject/teraterm/releases/tag/v5.2
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 3. During installation, in a Windows Security dialog , select the Always trust software from "Renesas Solutions 
Corp" checkbox.

 4. Click Install, and then click Next.

Figure 18. Windows Security prompt for USB driver installation
 5. After installation completes, click Finish to exit the setup.
 6. From the Windows Start menu, launch the Renesas Flash Programmer tool
 7. Connect the RA6W2 EVK to the PC using the USB debug interface.

Figure 19. RA6W2 EVK hardware
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 8. In the tool, to create a new project, go to File > New Project.
 a. In Microcontroller, select the RA6W1, RA6W2 group as the target microcontroller.

Figure 20. Selecting RA6W1, RA6W2
 b. In Project Name, enter the needed project name, and click Connect.
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Figure 21. Connecting RA6W2 EVK
When the device is connected, the status message "Operation completed" appears.
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Figure 22. Connection status – Operation completed
 9. Select Add/Remove Files, then browse, select All Files and choose the .img file to be programmed.

 10. In the File Offset dialog, click OK.
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Figure 23. File Offset dialog
 11. In the File details dialog, to confirm the selection, click OK again.
 12. In Renesas Flash Programmer, to flash the image, click Start.
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Figure 24. Start programming
A Progress Report window appears, showing the running progress. When programming is completed, the status 
dialog shows "Operation completed", showing that the firmware image is successfully written to the RA6W2 EVK.

4.1.2    Program Firmware Images for Linux
Programming firmware images to EVK in Linux requires the CLI tool of Renesas Flash Downloader.
System requirements:
 n OS: Ubuntu 22.04.4 LTS or later.
 n J-Link Linux driver – J-Link Version 864 or later.
 n Renesas Flash Programmer V3.22.00 or later
 n Hardware: RA6W2 EVK.
To program the firmware:
 1. Extract the RFP_CLI_Linux_V32200_x64.tgz.

tar -xzf RFP_CLI_Linux_V32200_x64.tgz

 2. Go to the extracted folder and check the J-Link serial number.

cd linux-x64/
./rfp-cli -d RA6W2 -lt
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 3. Program the firmware.

./rfp-cli -d RA6W2 -tool jlink:<jlink_serial_no> -if swd -s 25M -auto -bin 0 <path_to_.img 
file>

For example of successful operation, see Figure 25.

Figure 25. Programming of firmware in Linux

4.1.3    Program Firmware Images for macOS
Programming firmware images to EVK in macOS requires the CLI tool of Renesas Flash Downloader.
System requirements:
 n OS: Mac OS 14 (Sonoma) or later versions.
 n J-Link driver – J-Link Version 864 or later.
 n  l Renesas Flash Programmer V3.22.00 or later

 l Hardware: RA6W2 EVK.

To program firmware:
 1. Extract the RFP_CLI_macOS_V32200_arm64.zip.

tar -xzf RFP_CLI_macOS_V32200_arm64.zip

 2. Go to the extracted folder and check the J-Link serial number.

cd macos-arm64
./rfp-cli -d RA6W2 -lt

 3. Program the firmware using this command:
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./rfp-cli -d RA6W2 -tool jlink:<jlink_serial_number> -if swd -s 25M -auto -bin 0 <path_to_.img 
file>

For example of successful operation, see Figure 26.

Figure 26. Programming of firmware in macOS

4.2  EK-RA6W2 Serial Debug Interface Configuration
The RA6W2 provides a command/debug interface on UART0 for performing configuration and diagnostic functions. 
Connect the USB cable to the USB debug interface on the RA6W2 EVK and start the terminal emulation program.

4.2.1    Configure Tera Term Serial Terminal Application
 1. In the Tera Term program, go to the Serial Port setup and select the lower numbered COM port (COM8, in this 

case) and configure it as in Table 3 and Table 4.

Figure 27. Serial port setup
 2. Connect USB cable to RA6W2 EVK and pressing Enter. The following prompt appears in the UART console:

[/RA6W2-RRQ61051]
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Table 3. Serial port configuration values
Settings Value

Baud Rate 115200

Data Bits 8

Parity None

Stop Bits 1

Flow Control (Hardware/Software) None

Table 4. Terminal settings
Settings Value
Receive LF

Transmit CR + LF

4.2.2    Configure Minicom for Linux
 1. Connect the USB cable to the USB Debug Interface on the RA6W2 EVK and open a terminal for the minicom.
 2. Start minicom using the following command:

developer:~$ sudo minicom -D /dev/ttyUSB0

 3. Enter the password. 
After entering the password, minicom terminal view opens, see Figure 28.
NOTE
/dev/ttyUSB0 is for the debug interface and /dev/ttyUSB1 is for the AT command interface

Figure 28.  Minicom terminal view
 4. To configure minicom, press Ctrl+A followed by Z. It prompts a command summary as shown in Figure 29.

Figure 29. Minicom command summary
 5. When prompt appears, type O to select O for "cOnfigure Minicom..O".
 6. In the configuration prompt, select Serial port setup.
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 7. Configure minicom values using letters as shown in Table 1 using letters to configure. For example, to select Baud 
rate, use E.

Figure 30. Setting minicom values
 8. After it is configured, use Save setup as dfl for saving as default.
 9. Press Enter. 

The Configuration saved dialog appears.

Figure 31. Configuration saved
 10. Click Exit.
 11. For proper minicom printing, press Ctrl+A followed by Z. It prompts the command summary in Figure 32.

Figure 32. Minicom command summary window
 12. Select U for Add Carriage Ret..U.
 13. To complete the configuration, press Enter. See Figure 33.
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Figure 33. Successful configuration

4.2.3    Configure RA6W2 EVK AT Command Interface
4.2.3.1    AT Command Jumper Configuration

For using AT Commands, flash wifi_ble_coex_at_uart_ek_ra6w2_ep.img.
Connect the following jumpers to facilitate the AT command UART connection, see Figure 34:
 n Connect P0_04 on J201 to FD0_SCLK_DA on J203
 n Connect P0_05 on J201 to FD1_DI_DA on J203
 n Connect FD3_CS on J3 to FD3_CS_D on J3
 n Connect FD2_DO on J3 to FD2_DO_D on J3
 n Connect FD1_DI on J3 to FD1_DI_D on J3
 n Connect FD0_SCLK on J3 to FD0_SCLK_D on J3
After connecting the jumpers, connect the RA6W2 to laptop through USB cable to access the AT command terminal.

Figure 34. Jumper connections

4.2.3.2    AT Command Terminal Configuration

The RA6W2 provides an AT command interface on UART1 for performing configuration. Connect the USB cable to the 
USB302 on the RA6W2 EVK and start the terminal emulation program. In the terminal emulation program, go to the 
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Serial Port setup and select the higher numbered COM port (COM9, in this case) and configure it as in Table 3 and  
Table 4.
For more AT command details, see AT Command Manual. For basic connection using AT commands, see 1 AT 
Command Wi-Fi Provisioning.
When connecting USB cable to EK-RA6W2, the screen is initially blank. Enter the following command (which is hidden 
by default) in the blank screen to enable echo output:

ATE //(hidden)
Echo on //(command return)
OK

4.3  Provision Wi-Fi
Provisioning a Wi-Fi device is the process of setting up the device to connect to a network and function properly. This 
involves configuring network settings, ensuring secure authentication, and assigning necessary parameters.

After the terminal emulator setup ( Section 4.2 ) , Please follow the below steps.

4.3.1    Factory Reset (Optional)
Factory reset reverts the board to default configurations. To reset the board to default settings, enter: factory in the 
UART console window through Tera Term (or your console emulator).
After Factory Reset, the RA6W2 reboots. The Easy Setup Wi-Fi configuration wizard appears automatically.

Figure 35. Reboot after factory reset

4.3.2    Setup for Station Mode
You can configure the Wi-Fi functions of the RA6W2 by running the Easy Setup Wi-Fi configuration wizard.
NOTE
In case of factory reset, the Easy Setup Wi-Fi configuration wizard appears and then follows the following prompts. If 
reconfiguring, complete the following step.

To configure the RA6W2 for operating in Station mode, open its debug console and run the setup command at the 
[/RA6W2-RRQ61051] prompt. To complete the setup, follow the following prompts:

../../../../../../../../../Content/RA6W1 Getting Started Guide/Appendix B AT Command Wi Fi Provisioning.htm
../../../../../../../../../Content/RA6W1 Getting Started Guide/Appendix B AT Command Wi Fi Provisioning.htm
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[/RA6W2 -RRQ61051] setup                        //Start the Easy Setup Wizard.
Stop all services for the setting.
 Are you sure ? [Yes/No] : Y                    //Enter Y to stop the services.
[ RA6W2 -RRQ61051 EASY SETUP – V4]
Country Code List:
AD  AE  AF  AI  AL  AM  AR  AS  AT  AU  AW  AZ  BA  BB  BD  BE  BF  BG  BH  BL
BM  BN  BO  BR  BS  BT  BY  BZ  CA  CF  CH  CI  CL  CN  CO  CR  CU  CX  CY  CZ
DE  DK  DM  DO  DZ  EC  EE  EG  ES  ET  EU  FI  FM  FR  GA  GB  GD  GE  GF  GH
GL  GP  GR  GT  GU  GY  HK  HN  HR  HT  HU  ID  IE  IL  IN  IR  IS  IT  JM  JO
JP  KE  KH  KN  KP  KR  KW  KY  KZ  LB  LC  LI  LK  LS  LT  LU  LV  MA  MC  MD
ME  MF  MH  MK  MN  MO  MP  MQ  MR  MT  MU  MV  MW  MX  MY  NG  NI  NL  NO  NP
NZ  OM  PA  PE  PF  PG  PH  PK  PL  PM  PR  PT  PW  PY  QA  RE  RO  RS  RU  RW
SA  SE  SG  SI  SK  SN  SR  SV  SY  TC  TD  TG  TH  TN  TR  TT  TW  TZ  UA  UG
UK  US  UY  UZ  VA  VC  VE  VI  VN  VU  WF  WS  YE  YT  ZA  ZW  ALL
 COUNTRY CODE ? [Quit] (Default KR) : KR            //Enter the country code.
SYSMODE(WLAN MODE) ?
        1. Station
        2. Soft-AP
        3. WiFi Direct
        4. WiFi Direct P2P GO Fixed
        5. Station & Soft-AP
 MODE ?  [1/2/3/4/5/Quit] (Default Station) : 1        //Enter 1 for Station mode.
BAND ?
        1. 2.4 GHz
        2. 5 GHz
        3. AUTO
 MODE ?  [1/2/3/Quit] (Default 3. AUTO) : 1            //Select Wi-Fi Frequency Band.
[ STATION CONFIGURATION ]
===========================================================================
[NO] [SSID]                                        [SIGNAL] [CH] [SECURITY]
---------------------------------------------------------------------------
[ 0] AndroidHotspot0568                                 -25   6        WPA2
[ 1] U+Net0208                                          -37   2        WPA2
[ 2] wonhome                                            -49  11        WPA2
[ 3] SK_WiFiGIGA1200                                    -53   3  WPA / WPA2
[ 4] [Hidden] BSSID-0a:5d:dd:de:12:03                   -54   3        WPA2
[ 5] DIRECT-GWM2020 Series                              -56   3        WPA2
[ 6] AT_303_WBEH2GT_a879                                -66  11        WPA2
[ 7] olleh_WiFi_B602                                    -67  10  WPA / WPA2
[ 8] KT_GiGA_2G_Wave2_04A0                              -70   6  WPA / WPA2
[9] KT_GiGA_2G_Wave2_99EB                              -79   6  WPA / WPA2
[10] anyppi                                             -81   8        WPA2
---------------------------------------------------------------------------
[Enter] Rescan
===========================================================================
 Select SSID ? (1~11/Manual/Quit) : 0                //Enter the SSID NO from the list.
 PSK-KEY(ASCII characters 8~63 or Hexadecimal characters 64) ? [Quit]
n
:**********                            //Enter the password for the AP.
 Do you want to set advanced WiFi configuration ? [No/Yes/Quit] (Default No) : N
                                //Enter N to skip this step.
Enable DPM (Dynamic Power Management) ? [Yes/No/Manual/Quit] : N           //Enter N to disable 
DPM.
============================================
BAND        : 2.4 GHz
SSID      : AndroidHotspot0568
Security    : WPA2PSKENCRYPTION: TKIP/AES(CCMP)
Password: 123abc456
PMF         : Default
 WIFI CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y        //Enter Y to confirm the configuration.
IP Connection Type ? [Automatic IP/Static IP/Quit] : A    //Enter A for automatic DHCP IP address.
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IP Connection Type: Automatic IP
 IP CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y            //Enter Y to confirm the configuration.
 SNTP Client enable ? [Yes/No/Quit] : N            //Enter N to disable time sync.
     Connection COMPLETE to c8:9e:43:5f:e0:35
>>> Network Interface (wlan0) : UP
         Assigned addr   : 192.168.1.3
             netmask   : 255.255.255.0
               gateway   : 192.168.1.1
         DHCP Server IP  : 192.168.1.1
         Lease Time      : 24h 00m 00s
         Renewal Time    : 12h 00m 00s
 

The configuration is now complete and stored in NVRAM.
For setting up in different modes, see Appendix Appendix A Configuration Modes Setup.

4.3.3    Provision Wi-Fi Using Bluetooth® LE
Bluetooth® LE is available on the RA6W2 module. The RA6W2 module can be used in products such as "Wi-Fi door-
lock" where Wi-Fi is the main connection used during normal operation. Bluetooth® LE is a support connection used to 
perform Wi-Fi provisioning during the initial "Out-of-the-Box" setup of the product. A Bluetooth® LE peer application 
such as an Android/IOS mobile application provides an interface to provision the Wi-Fi interface of the RA6W2 device 
by providing configuration information such as a Wi-Fi Home router's SSID, password, and server information.

Figure 36. Provision through Bluetooth® LE diagram

To use the mobile application to provision the Wi-Fi connection on the RA6W2, see RA6W2 FreeRTOS Wi-Fi 
Provisioning over Bluetooth® LE Manual.
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5.    Test Procedures
The following sections describe several tests that verify the proper operation of the RA6W2 and demonstrates its 
various features.
The tests include:
 n Throughput Test – demonstrates the Wi-Fi performance of the RA6W2.
 n Current Consumption Measurements – demonstrates the amount of power used when the RA6W2 is in various 

Sleep modes or in Operational DPM mode.

5.1  Test Throughput with iPerf Traffic Generator
iPerf is a free IP-based a traffic generator tool that can be used for active measurements of the maximum achievable 
bandwidth on IP networks.
iPerf 2.1.3 (recommended) for Windows and Linux can be downloaded from 
https://sourceforge.net/projects/iperf2/files/.
There are various test setup types that can be used for Wi-Fi throughput tests:
 n Conducted – uses RF cables to connect the communicating devices. This effectively eliminates issues caused by 

the wireless domain.
 n Wireless/Over the Air – uses antennas connected to the station and access point, as opposed to RF cables, thus 

introducing additional elements and better replicating real-life usage.
 n Hybrid (Wireless plus Attenuation Control) – is the same as a wireless test setup, using antennas, but digital 

attenuators are also introduced as part of the signal path between the AP’s RF ports and antennas. This allows for 
total control over the RSSI, replicating varying distance between the Access Point and Station.

The provided examples work in any of the above scenarios.
NOTE
For clean and accurate results, Renesas recommends using an anechoic RF chamber for any of the mentioned tests.
Also use a dedicated Access Point for tests. If iPerf does not work and the issue is related to firewall restrictions, contact IT 
department.

5.1.0.1    Configure Testbed

To configure the Testbed:
 1. Download iPerf 2.1.3 from https://sourceforge.net/projects/iperf2/files/.
 2. Create a folder called "iperf" in the C:\ directory.
 3. Unzip the downloaded iPerf file (if necessary) and move the contents to the "iperf" folder.
 4. Rename the downloaded iperf executable file from "iperf-2.1.3-win.exe" to "iperf.exe".
 5. To ensure stable iPerf testing, run the Windows Security APP and turn off the network firewall. It is recommended 

to disable the laptop from all network firewalls before attempting a test.
To set up the Test Environment after setting up the iPerf:
 1. Connect your computer to the LAN port of an Access Point (such as the Asus RT-AX88U) through an ethernet 

cable.
The computer should receive an automatic IP address from the Access Points DHCP server. If the Access Point is 
configured to not provide automatic IP addresses, make sure to manually configure your computer to use a 
suitable IP address and subnet mask. Make sure that the computer is not connected to any other networks over 
ethernet or Wi-Fi.

 2. Connect EK-RA6W2 EVK wirelessly to the same Access Point.
 3. Connect EK-RA6W2 EVK wirelessly to the same Access Point SSID.
 4. To verify a properly configured connection, ping the RA6W2 from your computer or ping it from the RA6W2 to your 

computer.

https://sourceforge.net/projects/iperf2/files/
https://sourceforge.net/projects/iperf2/files/
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net
ping <destination IP address>

5.1.1    EK-RA6W2 as iPerf Client
The provided UDP uplink iPerf example can be used to primarily evaluate TX throughput speeds.

Figure 37. UDP uplink iPerf example
To configure as iPerf server for Windows:
 1. Start an iPerf Server on your laptop by opening the command prompt and navigating to the directory in which iPerf 

is located.
 2. Type "ipconfig" in the command prompt to see your laptop’s IP address.

Figure 38. IP address
 3. Start the UDP server in the Windows command prompt.

iperf.exe –s -i1 -u
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Figure 39. Start UDP
To run traffic from the EK-RA6W2 to the iPerf server on the Windows computer:
 1. Select the network Command mode, in the Tera Term console, by typing the net command.
 2. Start the UDP client:

iperf -I WLAN0 -c <Server IP> -t 10 -i 1 -u

 3. Read the throughput measurements from the iPerf server window.

Figure 40. Start UDP client

Figure 41. Measurements

5.1.2    EK-RA6W2 as iPerf Server
The provided UDP downlink iPerf example can be used to primarily evaluate RX throughput speeds.
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Figure 42. UDP downlink iPerf example
To configure EK-RA6W2 as iPerf Server
 1. To select the network command mode, type the net command in the Tera Term console.
 2. Start the UDP server:

iperf -I WLAN0 -s -u -i 1

Figure 43. Start UDP
To run Traffic from Windows Computer as iPerf Client:
 1. Close the existing command prompt on the laptop running the UDP server.
 2. Open the command prompt and navigate to the directory where iPerf is located.
 3. Start the UDP client in the Windows command prompt:

iperf.exe -c <Server IP> -t 10 -i 1 -u -b100m
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Figure 44. Start UDP client

5.2  Measure Current Consumption
NOTE
Current consumption measurement through SmartSnippets is available only after releasing the latest EVK.

There are numerous available methods for measuring current consumption to evaluate the power save performance 
of different Sleep modes and DPM configurations. Currently measurements are supported only for the Wi-Fi part of the 
RA6W2.
The following instructions explain how to perform such measurements using the SmartSnippets Toolbox or a standard 
power analyzer and focus measuring current consumption in forced Sleep modes and DPM mode.

5.2.1    PMGR Sleep Mode CLI Commands
RA6W2 can be configured to temporarily enter Power Manager (PMGR) Sleep mode 2 to Sleep mode 3 for a 5 second 
duration through CLI commands (custom durations are not yet supported):

pmgr force
- Usage: force [lld_states: PMGR_LLD_POWER_MODE_SLEEP2, PMGR_LLD_POWER_MODE_SLEEP3, PMGR_LLD_POWER_
MODE_SLEEP4, PMGR_LLD_POWER_MODE_DPM,    PMGR_LLD_POWER_MODE_CPU_WFI, PMGR_LLD_POWER_MODE_AUTO]

Example:

pmgr force PMGR_LLD_POWER_MODE_SLEEP3

To prepare SmartSnippets Toolbox:
 1. Download and install the latest version of the SmartSnippets Toolbox for current measurement from the Renesas 

Product webpage or from the provided evaluation Software package.

Figure 45. SmartSnippets toolbox
 2. Connect jumpers between the pins highlighted in red in Figure 46. LED light turns on when jumper J102 is set.
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Figure 46. Jumper setting
 3. Connect the EVK to your computer through USB.
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5.2.2    Measure with SmartSnippets
To measure the current consumption with SmartSnippets:
 1. Disassemble the RA6W2 daughterboard from the motherboard and power up the EVK through USB to your 

computer.
 2. Close any open instances of the UART COM port.
 3. Open SmartSnippets Toolbox on your computer.
 4. Select Board > Device > RA6W2_WI-FI.

Figure 47. RA6W2 device
 5. On the Chart View tab, select VBAT_WI-FI and CH1/CH2 Charge checkboxes.

Figure 48. Chart View tab
You should see the VBAT Wi-Fi – CH1/CH2 current measurement window.

 6. Identify the EK-RA6W2-related COM ports through the Windows Device Manager.
 7. Based on the identified pair of COM ports belonging to the RA6W2 EVK (in this case COM21 and COM22), select 

the following configurations:
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 a. Select Board > PowerProfiler > COM22 (Higher-numbered COM port).

Figure 49. Power profiler port
 b. Select OffsetCalibration > CH1/CH2 in SmartSnippets.

Figure 50. Offset calibration
NOTE
Offset calibration is required to find the current consumption values of motherboard before inserting daughterboard. This 
way the measurement of daughterboard is accurate. Calibration takes 10 seconds, and the values are saved in the 
configuration.

 8. Connect the RA6W2 EVK daughterboard to the motherboard.

Figure 51. EVK daughterboard to the motherboard connection
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 9. Press down the RST_N (Reset) button on the RA6W2. If the board has previous connection to an AP, it 
automatically re-connects.

Figure 52. Reset button
 10. In SmartSnippets, select Start.
 11. Connect to the console through UART using Tera Term, see Section 4.2 EK-RA6W2 Serial Debug Interface 

Configuration.
 12. In the UART console, select the needed configuration:

Example:
Configure the RA6W2 as in Station + DPM mode (see Appendix A.3 Set up Station Mode with DPM Enabled).
//OR//
Enter forced sleep modes (2 or 3) by using the following command syntax: "pmgr force <mode>"
pmgr force PMGR_LLD_POWER_MODE_SLEEP3

 13. In SmartSnippets, select Stop.
 14. To measure the average current consumption over a selected period, on the Tools tab, click Measure.
 15. Click and drag the measurement cursor over the section that you want measure in the top screen (CH1/CH2 

Current – VBAT) and read the "Iav" measurement for the average current between the selected measurement 
points.

Figure 53. Measurement points
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5.2.3    Measure with Power Analyzer
To measure the current consumption with Power Analyzer:
 1. On the Power Analyzer, select the current measurement mode.
 2. Connect jumpers between the pins and connect the current measurement points to the power analyzer, see Figure 

54.

Figure 54. Jumper connections between pins
 3. Assemble the daughterboard to the motherboard and turn on the EVK by connecting it to your computer through 

USB C.
 4. Connect to the console through UART using Tera Term, see Section 4.2 EK-RA6W2 Serial Debug Interface 

Configuration.
 5. In the UART console, select the needed configuration:

Example:
Configure the RA6W2 as in Station + DPM mode (see Appendix A.3 Set up Station Mode with DPM Enabled).
//OR//
Enter forced Sleep modes (2 or 3) by using the following command syntax: "pmgr force <mode>"
pmgr force PMGR_LLD_POWER_MODE_SLEEP 3

 6. Perform measurements with the power analyzer:
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Figure 55. Measurements
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5.2.4    Measure Sleep 1 Current Consumption
Measuring the current consumption for Sleep 1 follows the same process as described in Section 4.3.2 Setup for 
Station Mode and Appendix A.1 Set up Soft AP Mode, but it does not require any configuration in the CLI.
The following modifications are needed in the test setup to force the device to Sleep 1 Mode:
 1. Remove the pull-up on the RST of the daughterboard.

Figure 56. Remove resistor
 2. Remove the J210 jumper on the motherboard.
 3. Connecting a jumper between the GND and J210 RST_N pins.

Figure 57. Connecting jumper between pins



RA6W2 Getting Started Guide

R19US0018EK0104   Rev.1.04 Page 44
May 7, 2026

5.2.5    Power Consumption Measurement for Combo (RA6W2/RRQ61051 Wi-Fi Only)
Current measurement can be performed with external equipment by connecting pins VLDOP_A and VBAT_A to J102:
 1. Remove jumper from J2.
 2. Set wire connection between J104 pin 1 and J2 pin 1.

Figure 58. Connecting jumper between pins RA6W2/RRQ61051 Wi-Fi only
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5.2.6    Power Consumption Measurement for Combo (RA6W2/RRQ61051 Bluetooth LE 
only)
Current measurement can be performed with external equipment by connecting to J2:
 n Place jumper on pins 2 and 3 of J102.

Figure 59. Connecting jumper between pins RA6W2/RRQ61051 Bluetooth LE only
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5.2.7    Power Consumption Measurement for Combo (RA6W2/RRQ61051 both Wi-Fi and 
Bluetooth LE)
Current measurement can be performed with external equipment by connecting pins VLDO_P and VBAT_A to J102.

 

Figure 60. Connecting jumper between pins RA6W2/RRQ61051 both Wi-Fi and Bluetooth LE
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6.    Software Development Kit and Build Setup
Wi-Fi applications can be developed for the RA6W2 using the RA6W2 FreeRTOS Software Development Kit (SDK) 
and the Renesas e2 studio IDE on either a Windows 10, Linux or macOS based development system.
To start developing applications for the RA6W2, complete the following steps:
 1. Install and configure the e2 studio IDE.

 2. Import the RA6W2 SDK into the e2 studio IDE and build an application.

 3. Download and test the application.
 4. Use J-Link debugger to debug the application.
Figure 61 shows the typical e2 studio project for the RA6W2 FSP.

Figure 61. Project view
System requirements:
 n Windows 10 64 bit or later versions
 n Ubuntu 22.04 LTS or later versions
 n macOS 14 (Sonoma) or later versions
 n e2 studio installer-2025-12 or later versions.
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6.1  Install e2 studio IDE for Windows
The following files are required for installation in Windows and can be found in the RA6W2 Software and Tools section 
in product page:
 n e2 studio installer – e2studio_installer-2025-12_windows_host.exe.
 n RA6W2 FSP pack – RAFW_FSP_Packs_2.0.1.
 n J-Link V878 or later.
To install e2 studio IDE for Windows:
 1. Run the installer, in the e2studio setup wizard, select Standard Install, and then select Next.

Figure 62. Standard installation
 2. On the Device Families step, select RA for Wireless.
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Figure 63. Device families
 3. On the Additional Software step, expand GCC Toolchains and Utilities, select the GNU ARM Embedded 13.3 

checkbox, and click Next.

Figure 64. Additional software
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 4. On the Licenses step, accept the terms of the software agreement by selecting the checkbox, and click Next.
 5. On the Shortcuts step, click Next.

Figure 65. Shortcuts
 6. On the Summary step, click Install.
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Figure 66. Ready to install
 7. While installing e2 studio, GNU Arm® Embedded 13.3 toolchain installation initializes.

Figure 67. Toolchain installation
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 8. Complete the toolchain installation.

Figure 68. Toolchain setup wizard
 9. When the e2 studio is installed, select the Launch e2 studio checkbox and click OK.

 10. Open e2 studio and continue with installing the RA6W2 FSP pack.

Figure 69. Welcome to e2 studio
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6.2  Install e2 studio IDE for Linux
The following files are required for installation for Linux and can be found in the RA6W2 Software and Tools section in 
product page:
 n e2 studio installer – e2studio_installer-2025-12_linux_host.run.
 n RA6W2 FSP pack – RAFW_FSP_Packs_2.0.1.
 n J-Link V878 or later.
To install e2 studio IDE for Linux:
 1. Give the execution permissions to the e2 studio installer and run installer, see Figure 70.

Figure 70. Installer
 2. In the e2studio setup wizard, select Standard Install, and select Next.

Figure 71. Standard installation
 3. On the Device Families step, select RA for Wireless.
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Figure 72. Device families
 4. On the Additional Software step, expand GCC Toolchains and Utilities, select the GNU ARM Embedded 13.3 

checkbox, click Next > Install, see Figure 73.

Figure 73. Device families
 5. After completing e2 studio installation, open e2 studio and continue with installing the RA6W2 FSP pack.

See Section 6.4 Install RA6W2.
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Figure 74. e2 studio

6.3  Install e2 studio IDE for macOS
 n e2 studio installer – e2studio_installer-2025-12_macosx_host.txz.
 n RA6W2 FSP pack – RAFW_FSP_Packs_2.0.1.
 n J-Link V878 or later.
 n Toolchain Installer – arm-gnu-toolchain-13.3.rel1-darwin-arm64-arm-none-eabi.pkg.
 n Python 3 Installer – python-3.13.6-macos11.pkg.
To install e2 studio IDE for macOS:
 1. In the downloaded archive, extract the E2studio.app file and move it to the application folder.
 2. In the application folder, double-click E2studio.app to start the e2 studio.

If the E2studio.app is damaged and can’t be opened, you should move it to the Trash. Error message appears 
when the e2 studio is started, see Figure 75, open the terminal window and run the following command:

xattr -d com.apple.quarantine /Applications/E2studio.app

Figure 75. Error in Starting e2 studio

 3. Install the Toolchain by double-clicking the installer.
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Figure 76. Toolchain Installer
 4. After Toolchain Installation is successfully completed, in e2 studio, go to Help > Add Renesas Toolchains, see 

Figure 77.

Figure 77. Add Renesas Toolchains
 5. In the Renesas Toolchain Management dialog, click Add.
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Figure 78. Renesas Toolchain Management
 6. In the Add New Toolchain dialog, click Browse.
 7. Go to Applications > ArmGNUToolchain > 13.3.rel1 > arm-none-eabi, and click Open.

Figure 79. Choose the Installed Toolchain
 8. In the Add New Toolchain dialog, click OK.
 9. In the Renesas Toolchain Management dialog, click Apply and Close.
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Figure 80. Finalize Toolchain Settings
 10. Install Python3 by double-clicking Installer – python-3.13.6-macos11.pkg.

Figure 81. Python3 Installer
 11. After Python3 installation is completed successfully, restart e2 studio using File > Restart.
 12. Install Renesas QE using Renesas Views > Renesas Software Installer, Figure 82.
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Figure 82. Renesas Views > Renesas Software Installer
 13. Select Renesas QE, and then click Next.
 14. Select QE for BLE[RA,RE,RX] [v1.8.0], and then click Finish.

Figure 83. QE for BLuetooth LE
 15. Click Next.
 16. Accept terms and conditions and click Finish.
 17. Click Select All and Trust Selected.
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Figure 84. Trust Authorities
 18. Click Select All and Trust Selected again.

Figure 85. Trust Artifacts
 19. Restart e2 studio by clicking the Restart Now.

6.4  Install RA6W2
To build the SDK, install the RA6W2 FSP pack:
NOTE
The same procedure applies to both Windows OS, Linux and macOS.

To install the latest RA6W2 FSP Release package:
 1. Unzip the RAFW_FSP_Packs_2.0.1.zip to the e2 studio install directory.
 2. To find the exact e2 studio install directory, click Help > About e2 studio. For macOS, click e2studio > About 

e2studio.
 3. In the About e2studio dialog, click Installation Details.
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Figure 86. e2 studio details

 4. In the e2 studio Installation Details dialog, select the Support Folders tab.

Figure 87. e2 studio installation details
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 5. To open the system file manager in the directory that corresponds to e2 studio install directory, click the e2 studio 
support area link.

Figure 88. Support folders
 6. Extract the RAFW_FSP_Packs_2.0.1.zip file.
 7. Copy and paste the Internal folder to the e2 studio support folder.

In MacOS, select the Merge option when copying the internal folder.
 8. To restart e2 studio, click File > Restart.
NOTE
For updating/re-installing the RRQ_FSP_Packs, delete the following folders in the e2 studio support folder first.

 n DebugComp\rrq\
 n internal\cmsis\data\rrq\
 n internal\devassist\rafw_fsp\
 n internal\projectgen\rafw_fsp\.
Then follow Step 5 and Step 8.

6.5  Load Project Template in e2 studio
To load the project template:
 1. Extract the wifi_ble_coex_ek_ra6w2_ep.zip project template to a directory.
 2. To import project template, click File > Import.
 3. Under General, select Rename & Import Existing C/C++ Project into Workspace.

Figure 89. Rename and import
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 4. Go to the project template directory (unzip wifi_ble_coex_ek_ra6w2_ep.zip), and in the Project name field, enter 
the name and click Finish.

 5. In the Project name field, enter the name and click Finish, see Figure 90.

Figure 90. Finish import
 6. After import finishes, install python using the following steps in Windows:

 a. Right-click the project, click Show in Local Terminal > Terminal.
 b. In console, enter "python3".

NOTE
For Windows, if Python 3 is installed already and above terminal appears, for python Integration, see Appendix D Python 
Integration in e2 studio Windows.

 c. Microsoft store appears and to install Python 3, click Get.
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Figure 91. Install Python 3
 7. Go to configuration.xml and click Generate Project Content.

Figure 92. Configuration and generate project contents
 8. To build the project, right-click the project and click Build Project.
 9. To see the build progress, open the console window.

Figure 93. Console window
Figure 94 shows the successful build.
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Figure 94. Successful build
 10. If there is no .img.bin file generated on Windows and Python 3 command does not show any error in console, 

follow the step 6.

Figure 95. Image in Project Explorer tab

6.6  Flash and Debug using e2 studio
You can flash and debug in e2 studio using J-Link.
System Requirements:
 n e2 studio installer-2025-12 or later versions
 n Segger J-Link V878 or later.
To flash and debug in e2 studio:
 1. Install RA6W2 FSP Pack and Load Project Template in e2 studio.
 2. Build Debug for RA6W2.
 3. Go to Debug > Debug New_configuration.
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Figure 96. Debug Configuration in e2 studio

 4. In Debug Configurations, select Renesas GDB Hardware Debugging, and then select Launch 
Configuration.

Figure 97. Debug Configuration page
 5. On the Debugger tab, set up the target device as follows:
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Figure 98. Device selection in Debugger
 6. On the Startup tab, and change load type of Program Binary to Symbols Only.

Figure 99. Symbols only
 7. To add Download Module (.img.bin) from Debug, go to Add > Workspace > Project File > Debug > test_files 

> .img.bin.



RA6W2 Getting Started Guide

R19US0018EK0104   Rev.1.04 Page 68
May 7, 2026

Figure 100. Add Download Module 
 8. Change Load Type of .img.bin into Raw Binary and Offset as a000000. Then click Apply > Debug.

Figure 101. Change Load type and Offset
 9. Click Switch.
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Figure 102. Confirm Perspective Switch and Segger J-Link
 10. On Debug page, click Play.

Figure 103. Debug Page
 11. By putting a breakpoint in a file you can debug normally using debug interface. Go to C/C++ > Choose a breakpoint 

> Debug > Resume button.
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Figure 104. Debug by setting breakpoint
For more details about debugging in e2 studio, see JTAG Manual.
After flashing successfully, for test procedures, see Section 1 Test Procedures.

6.7  Configure Bluetooth® LE in RA6W2 Using Renesas QE
NOTE  
Proceed with caution when using QE to regenerate the code in existing templates.
QE for Bluetooth LE provides user code protection during code generation. Code added within the following code block is retained 
after code generation. When implementing it in each program, implement it between these comments:
/* Start user code for XXXX. Do not edit comment generated here */

Implement user code here

/* End user code. Do not edit comment generated here */

Custom codes outside this block will be erased during QE generate action.

To Open Renesas QE in e2 studio, click Renesas Views > Renesas QE > R_BLE Custom Profile RA,RE,RX(QE).

Figure 105. Renesas QE
To change Bluetooth® LE Local Name Using Renesas QE:
 1. In R_BLE Custom Profile tab, select Peripheral tab and complete the following changes:

 a. In the Project dropdown list, select the required Bluetooth LE project.
 b. In the Module dropdown list, select DA1453x.
 c. On the Peripheral tab, select the Local Name checkbox and give custom local name.

 2. To generate Bluetooth LE code with current change, click Generate Code.

../../../../../../Content/RA6W1 Getting Started Guide/Test Procedures.htm
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Figure 106. Changing local name

Figure 107. Successful code generation
 3. To build the project again, right-click the project and click Build Project.
When the image is loaded in the RA6W2 device, the change can be verified using Renesas SmartBond application.

Figure 108. Changes reflected in SmartBond application

6.8  Run on Device
For manual firmware programming , see Section 4.1 Firmware Image Programming.
After flashing the image, to verify the  proper operation, see Section 5 Test Procedures.
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7.    Example Projects
Renesas provides several example projects that demonstrate different capabilities of the RAFW MCUs. These 
example projects can be a good starting point for you to develop custom applications.
Example projects (source code and project files) for RA6W2 are available in the RAFW FSP Examples GitHub. The 
link to GitHub is available on the Software and Tools section of RA6W2 web page:
 n wifi_ble_coex_ek_ra6w2_ep.zip
 n wifi_ble_provisioning_ek_ra6w2,zip
 n wifi_ble_codeless_ek_ra6w2_ep.zip
wifi_ble_coex_ek_ra6w2_ep template
This is the basic template for Wi-Fi and Bluetooth LE. This template demonstrates the coexistence of Bluetooth LE and 
Wi-Fi in the RA6W2. For Bluetooth LE, the Renesas SmartBond™ app is available, which can be found in Google play 
store, and for Wi-Fi, a command-line interface is available as well.
wifi_ble_provisioning_ek_ra6w2_ep template
This is the basic template for demonstrating Wi-Fi provisioning using Bluetooth LE. This is done using the Renesas 
WiFiProvisioning app in play store. If the development environment is Windows, the application has a dependency on 
a JSON library, and it can be downloaded from https://github.com/zserge/jsmn/blob/master/jsmn.h and put to 
e2_studio\workspace_2\<project_name>\thirdparty folder.

Figure 109. Dependency added in third-party folder
wifi_ble_codeless_ek_ra6w2_ep template
The CodeLess™ is a Bluetooth LE solution which uses AT commands (ASCII Instructions) to perform various 
Bluetooth LE tasks. The Codeless AT commands can be used to control Bluetooth LE connectivity such as 
connect/disconnect, start advertising, stop advertising, change roles (central/ peripheral), scan nearby devices, and 
interact with sensor for read/ write operations and raw data transfer. Renesas SmartConsole application can be used 
for testing codeless template.
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Appendix A Configuration Modes Setup

A.1 Set up Soft AP Mode
Soft AP mode allows you to provision the RA6W2 through the Wi-Fi interface using a mobile application and configure 
it by running the Easy Setup Wi-Fi configuration wizard.
To configure the RA6W2 for operating in Soft AP mode:
 1. Open the RA6W2 debug console and run the setup command in the [/RA6W2-RRQ61051] prompt.
 2. To complete the setup, complete the following prompts:

[/RA6W2-RRQ61051] setup                        //Start the Easy Setup Wizard.
Stop all services for the setting.
 Are you sure ? [Yes/No] : Y                    //Enter Y to stop the running services.
[ RA6W2-RRQ61051 EASY SETUP – V4 ]
Country Code List:
AD  AE  AF  AI  AL  AM  AR  AS  AT  AU  AW  AZ  BA  BB  BD  BE  BF  BG  BH  BL
BM  BN  BO  BR  BS  BT  BY  BZ  CA  CF  CH  CI  CL  CN  CO  CR  CU  CX  CY  CZ
DE  DK  DM  DO  DZ  EC  EE  EG  ES  ET  EU  FI  FM  FR  GA  GB  GD  GE  GF  GH
GL  GP  GR  GT  GU  GY  HK  HN  HR  HT  HU  ID  IE  IL  IN  IR  IS  IT  JM  JO
JP  KE  KH  KN  KP  KR  KW  KY  KZ  LB  LC  LI  LK  LS  LT  LU  LV  MA  MC  MD
ME  MF  MH  MK  MN  MO  MP  MQ  MR  MT  MU  MV  MW  MX  MY  NG  NI  NL  NO  NP
NZ  OM  PA  PE  PF  PG  PH  PK  PL  PM  PR  PT  PW  PY  QA  RE  RO  RS  RU  RW
SA  SE  SG  SI  SK  SN  SR  SV  SY  TC  TD  TG  TH  TN  TR  TT  TW  TZ  UA  UG
UK  US  UY  UZ  VA  VC  VE  VI  VN  VU  WF  WS  YE  YT  ZA  ZW  ALL
 COUNTRY CODE ? [Quit] (Default KR) : US            //Enter the country code.
SYSMODE(WLAN MODE) ?
        1. Station
        2. Soft-AP
        3. WiFi Direct
        4. WiFi Direct P2P GO Fixed
        5. Station & Soft-AP
 MODE ?  [1/2/3/4/5/Quit] (Default Station) : 2        //Enter 2 for Soft-AP mode.
BAND ?
        1. 2.4 GHz
        2. 5 GHz
 BAND ?  [1/2/Quit] (Default 1. 2.4GHz) : 1                   //Enter 1 for 2.4 GHz Band
[ SOFT-AP CONFIGURATION ]
 SSID ? (Default RA6W2-RRQ61051_9FFFFE) : TEST AP             //Enter the SSID name.
 CHANNEL ? [1~13, Auto:0/Quit] (Default Auto) :        //Enter to select Auto channel selection.
AUTHENTICATION ?
         1. OPEN                                        // No authentication or encryption; 
unsecured network
         2. WEP(Unsupported)                            // Legacy RC4-based security; deprecated 
and insecure
         3. WPA-PSK                                     // Uses TKIP; deprecated with known 
vulnerabilities
         4. WPA2-PSK                                    // AES-CCMP encryption; widely used and 
secure
         5. WPA/WPA2-PSK                                // Mixed mode for backward compatibility 
(TKIP + AES)
         6. WPA3-SAE (WPA3-Personal)                    // Modern secure authentication using SAE; 
resists brute-force attacks
         7. WPA2-PSK+WPA3-SAE (Recommend)               // Transition mode supporting both WPA2 and 
WPA3 clients
         8. WPA3-OWE                                    // Enhanced Open ; no password but 
encrypted traffic
 
 AUTHENTICATION ? [1/3/4/5/6/7/8/Quit] : 4            //Enter 4 to select WPA2-PSK authentication.
 PSK-KEY(ASCII characters 8~63 or Hexadecimal characters 64) ? [Quit]
:**********                            //Enter the password for the AP.



RA6W2 Getting Started Guide

R19US0018EK0104   Rev.1.04 Page 74
May 7, 2026

 Do you want to set advanced WiFi configuration ? [No/Yes/Quit] (Default No) : N
                                //Enter N to skip this step.
============================================
BAND        : 2.4 GHz
SSID      : TEST AP
CHANNEL   : AUTO(ACS)
AUTH      : WPA2PSK
ENCRYPTION: AES(CCMP)
PSK KEY   : 123abc456
KEY TYPE  : ASCII
WIFI MODE : 11b/g/n (2.4GHz)
PMF         : Default
============================================
 WIFI CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y                //Enter Y to confirm the WIFI
                                           configuration.
 IP ADDRESS ? [Quit] (Default 10.0.0.1) :            //Enter to select the default IP Address. 
Unique identifier 
                                                                   assigned to a device on the 
network.
 
 SUBNET ? [Quit] (Default 255.255.255.0) :               //Enter to select the default Subnet. 
Defines network and host
                                                                  portions of the IP address
 
 GATEWAY ? [Quit] (Default 10.0.0.1) :                     //Enter to select the default 
Gateway.Default router address
                                                                  used to access external networks
 
============================================
[WLAN1]
IP ADDRESS: 10.0.0.1
SUBNET    : 255.255.255.0
GATEWAY   : 10.0.0.1
============================================
 IP CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y            //Enter Y to confirm the IP configuration.
 DHCP SERVER CONFIGURATION ? [Yes/No/Quit] : Y              //Enter Y to confirm the DHCP Server 
configuration. Automatically    
                                                                 assigns IP, gateway, and subnet 
mask to devices.
                            
 DHCP SERVER LEASE IP Count(MAX 10) ? [Quit] (Default 10) :
                                //Enter to select the default Lease Count.
 DHCP SERVER LEASE TIME(60 ~ 86400 SEC) ? [Quit] (Default 1800) :
                                //Enter to select the default Lease Time.
============================================
[DHCP SERVER]
Start IP  : 10.0.0.2
END IP    : 10.0.0.11
LEASE TIME: 1800
============================================
 DHCP SERVER CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y    //Enter Y to confirm the configuration.
[/RA6W2-RRQ61051] # >>> wpa_supplicant_deinit ...
[wpa_supplicant_deinit_iface] CTRL-EVENT-TERMINATING 
>>> Request Supplicant start 
>>> Renesas RA6W2-RRQ61051 wpa_supplicant 2.10 - Sep/2023
>>> Add SoftAP Inteface (softap1) ...
>>> MAC address (softap1) : ec:9f:0d:9f:ff:ff
[init_net_ifaces]: Switching WiFi mode to: Soft-AP
[init_net_ifaces]: Setting up AP (wlan1)
<<Please check MAC address.>>
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Stop DHCP Server
INFO: DHCP Server is not running.
Start DHCP Server
>>> AP Operating Channel: AUTO
>>> DHCP Server Started
Soft-AP is Ready (ec:9f:0d:9f:ff:ff)
 

When all settings are complete, the configuration is saved. Then, the "Soft AP mode started successfully" message 
should be printed.

A.2 Set up Concurrent Mode
To configure the RA6W2 for operating in Concurrent mode (that is, configuring it for both Station and Soft AP modes):
 1. Open the RA6W22 debug console and run the setup command in the [/RA6W2-RRQ61051] prompt.
 2. Follow the prompts to complete the setup:

[/RA6W2-RRQ61051] # setup
Stop all services for the setting.
 Are you sure ? [Yes/No] : y
>>> Network Interface (wlan0) : DOWN
>>> Network Interface (wlan0) : DOWN
[ RA6W2-RRQ61051 EASY SETUP – V4 ]
Country Code List:
AD  AE  AF  AI  AL  AM  AN  AR  AS  AT  AU  AW  AZ  BA  BB  BD  BE  BF  BG  BH  
BL  BM  BN  BO  BR  BS  BT  BY  BZ  CA  CF  CH  CI  CL  CN  CO  CR  CU  CX  CY  
CZ  DE  DK  DM  DO  DZ  EC  EE  EG  ES  ET  EU  FI  FM  FR  GA  GB  GD  GE  GF  
GH  GL  GP  GR  GT  GU  GY  HK  HN  HR  HT  HU  ID  IE  IL  IN  IR  IS  IT  JM  
JO  JP  KE  KH  KN  KP  KR  KW  KY  KZ  LB  LC  LI  LK  LS  LT  LU  LV  MA  MC  
MD  ME  MF  MH  MK  MN  MO  MP  MQ  MR  MT  MU  MV  MW  MX  MY  NG  NI  NL  NO  
NP  NZ  OM  PA  PE  PF  PG  PH  PK  PL  PM  PR  PT  PW  PY  QA  RE  RO  RS  RU  
RW  SA  SE  SG  SI  SK  SN  SR  SV  SY  TC  TD  TG  TH  TN  TR  TT  TW  TZ  UA  
UG  UK  US  UY  UZ  VA  VC  VE  VI  VN  VU  WF  WS  YE  YT  ZA  ZW  ZZ  
 COUNTRY CODE ? [Quit] (Default KR, ZZ : for debug) : us
SYSMODE(WLAN MODE) ?
        1. Station
        2. Soft-AP
        3. WiFi Direct
        4. WiFi Direct P2P GO Fixed
        5. Station & Soft-AP
 MODE ?  [1/2/3/4/5/Quit] (Default Station) : 5
BAND ?
        1. 2.4 GHz
        2. 5 GHz
        3. AUTO
 BAND ?  [1/2/3/Quit] (Default 3. AUTO) : 1      
[ STATION CONFIGURATION ]
============================================================================
[NO] [SSID]                                         [SIGNAL] [CH] [SECURITY]
----------------------------------------------------------------------------
[ 0] WiFi_Net_2.4G                                      -26   6     WPA2-ENT
[ 1] RenesasMatter                                      -26  10         WPA2
[ 2] REL-GLOBAL                                         -27   6     WPA2-ENT
[ 3] NETGEAR81                                          -36   3         WPA2
[ 4] GGG_AP_2G                                          -36  11         WPA2
----------------------------------------------------------------------------
[Enter] Rescan
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============================================================================
 Select SSID ? (1~5/M1~M5/Manual/Quit) : 1
 PSK-KEY(ASCII characters 8~63 or Hexadecimal characters 64) ? [Quit]
:*********
 Do you want to set advanced WiFi configuration ? [No/Yes/Quit] (Default No) : n
============================================
BAND        : 2.4 GHz
SSID        : RenesasMatter
Security        : WPA/WAP2-PSK
ENCRYPTION  : TKIP/AES(CCMP)
Password     : *********
PMF     : Default
============================================
 WIFI CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
IP Connection Type ? [Automatic IP/Static IP/Quit] : a
IP Connection Type: Automatic IP
IP CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
SNTP Client enable ? [Yes/No/Quit] : n
[ SOFT-AP CONFIGURATION ]
<<Please check MAC address.>>
 SSID ? (Default RA6W2_9FFFFE) : 
AUTHENTICATION ?
         1. OPEN                                        // No authentication or encryption; 
unsecured network
         2. WEP(Unsupported)                            // Legacy RC4-based security; deprecated 
and insecure
         3. WPA-PSK                                     // Uses TKIP; deprecated with known 
vulnerabilities
         4. WPA2-PSK                                    // AES-CCMP encryption; widely used and 
secure
         5. WPA/WPA2-PSK                                // Mixed mode for backward compatibility 
(TKIP + AES)
         6. WPA3-SAE (WPA3-Personal)                    // Modern secure authentication using SAE; 
resists brute-force attacks
         7. WPA2-PSK+WPA3-SAE (Recommend)               // Transition mode supporting both WPA2 and 
WPA3 clients
         8. WPA3-OWE                                    // Enhanced Open ; no password but 
encrypted traffic
 AUTHENTICATION ? [1/3/4/5/6/7/8/Quit] : 4
 PSK-KEY(ASCII characters 8~63 or Hexadecimal characters 64) ? [Quit]
:12345678
 Do you want to set advanced WiFi configuration ? [No/Yes/Quit] (Default No) : n
============================================
 
SSID        : RA6W2-RRQ61051_9FFFFE
Security    : WPA2PSK
ENCRYPTION  : AES(CCMP)
Password    : 12345678
PMF         : Default
============================================
 WIFI CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
 IP ADDRESS ? [Quit] (Default 10.0.0.1) : 
 SUBNET ? [Quit] (Default 255.255.255.0) : 
 GATEWAY ? [Quit] (Default 10.0.0.1) : 
============================================
[WLAN1]
IP ADDRESS: 10.0.0.1
SUBNET    : 255.255.255.0
GATEWAY   : 10.0.0.1
============================================
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 IP CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
 DHCP SERVER CONFIGURATION ? [Yes/No/Quit] : y
 DHCP SERVER LEASE IP Count(MAX 10) ? [Quit] (Default 10) :
DHCP SERVER LEASE TIME(60 ~ 86400 SEC) ? [Quit] (Default 1800) :
============================================
[DHCP SERVER]
Start IP  : 10.0.0.2
END IP    : 10.0.0.11
LEASE TIME: 1800
============================================
 DHCP SERVER CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
>>> wpa_supplicant_deinit ...
[wpa_supplicant_deinit_iface] CTRL-EVENT-TERMINATING 
>>> Request Supplicant start 
>>> Renesas RA6W2-RRQ61051 wpa_supplicant 2.10 - Sep/2023
>>> MAC address (sta0) : ec:9f:0d:9f:ff:fe
>>> Add SoftAP Inteface (softap1) ...
>>> MAC address (softap1) : ec:9f:0d:9f:ff:ff
>>> Start STA & SOFT-AP Concurrent mode...
[init_net_ifaces]: Switching WiFi mode to: Station & Soft-AP
[init_net_ifaces]: Setting up Concurrent mode (AP + STA)
<<Please check MAC address.>>
Stop DHCP Server
INFO: DHCP Server is not running.
Start DHCP Server
>>> AP Operating Channel: 1(2412)
Soft-AP is Ready (ec:9f:0d:9f:ff:ff)
>>> DHCP Server Started
Connection COMPLETE to ce:15:31:6e:b9:41
>>> Network Interface (wlan0) : UP
Wakeup source is 0x4
        ******************************************************
        *              RA6W2-RRQ61051 SDK Information
        * ---------------------------------------------------
        *
        * - CHIP Name       : RA6W2-RRQ61051 (D3095B)
        * - SKU Type        : 0x20, Dual Band (2.4 + 5 GHz) WI-FI 6
        * - CPU Type        : Cortex-M33 (160MHz)
        * - Kernel Version  : FreeRTOS V11.1.0
        * - SFLASH Type     : 8 MB (Renesas AT25SL)
        * - SDK Version     : V8.0.3.0.2
        * - F/W Version     : RA6W2-RRQ61051-7a0e352c5e-1
        * - Boot Index      : 0
        * - F/W Build Time  : Apr 14 2026 12:33:57
        *
        ******************************************************
System Mode : Station & Soft-AP (4)
DPM TIM wake up range: 1 ~ 6000 
<<Please check MAC address.>>
Network init...<<Please check MAC address.>>
<<Please check MAC address.>>
OK
Start DHCP Server
>>> Renesas RA6W2-RRQ61051 wpa_supplicant 2.10 - Sep/2023
>>> MAC address (sta0) : ec:9f:0d:9f:ff:fe
>>> Add SoftAP Inteface (softap1) ...
>>> MAC address (softap1) : ec:9f:0d:9f:ff:ff
>>> Start STA & SOFT-AP Concurrent mode...
Stop DHCP Server
DHCP Server stopped.
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>>> AP Operating Channel: 1(2412)
Soft-AP is Ready (ec:9f:0d:9f:ff:ff)
BD address from device: 48:23:35:f4:00:11
BD address from device: 48:23:35:f4:00:11
Legacy advertising started
Legacy advertising started
Connection COMPLETE to ce:15:31:6e:b9:41
>>> Network Interface (wlan0) : UP
         Assigned addr   : 192.168.137.86
               netmask   : 255.255.255.0
               gateway   : 192.168.137.1
         DHCP Server IP  : 192.168.137.1
         Lease Time      : 168h 00m 00s
         Renewal Time    : 84h 00m 00s
 

A.3 Set up Station Mode with DPM Enabled
Dynamic Power Management (DPM) is a synthesis of breakthrough in ultra-low-power technologies that enable 
extremely low-power operation of the RA6W2. DPM shuts down all microelements on the chip when not in use, which 
allows a near zero level of power consumption when not actively transmitting or receiving data. DPM also enables 
Ultra-low-power Transmit and Receive modes when the MCU needs to be awake to exchange information with other 
devices. Advanced algorithms enable the device to stay asleep until the exact required moment to wake up to 
Transmit or Receive mode.
For more details about DPM, see PMGR DPM Application Note .
By default, the DPM functionality is enabled upon the device’s connection to an Access Point. This can be 
reconfigured by running the Easy Setup Wi-Fi configuration wizard. DPM allows for considerably reduced power 
consumption by periodically entering various sleep modes when full functionality is not required.
To configure the RA6W2 for operating in Station + DPM mode:
 1. Open theRA6W2 debug console and run the setup command in the [/RA6W2-RRQ61051] prompt.
 2. To complete the setup, complete the following prompts:

[/RA6W2-RRQ61051/dpm] # setup
Stop all services for the setting.
 Are you sure ? [Yes/No] : y
>>> Network Interface (wlan0) : DOWN
>>> Network Interface (wlan0) : DOWN
[ RA6W2 EASY SETUP ]
Country Code List:
AD  AE  AF  AI  AL  AM  AN  AR  AS  AT  AU  AW  AZ  BA  BB  BD  BE  BF  BG  BH  
BL  BM  BN  BO  BR  BS  BT  BY  BZ  CA  CF  CH  CI  CL  CN  CO  CR  CU  CX  CY  
CZ  DE  DK  DM  DO  DZ  EC  EE  EG  ES  ET  EU  FI  FM  FR  GA  GB  GD  GE  GF  
GH  GL  GP  GR  GT  GU  GY  HK  HN  HR  HT  HU  ID  IE  IL  IN  IR  IS  IT  JM  
JO  JP  KE  KH  KN  KP  KR  KW  KY  KZ  LB  LC  LI  LK  LS  LT  LU  LV  MA  MC  
MD  ME  MF  MH  MK  MN  MO  MP  MQ  MR  MT  MU  MV  MW  MX  MY  NG  NI  NL  NO  
NP  NZ  OM  PA  PE  PF  PG  PH  PK  PL  PM  PR  PT  PW  PY  QA  RE  RO  RS  RU  
RW  SA  SE  SG  SI  SK  SN  SR  SV  SY  TC  TD  TG  TH  TN  TR  TT  TW  TZ  UA  
UG  UK  US  UY  UZ  VA  VC  VE  VI  VN  VU  WF  WS  YE  YT  ZA  ZW  ZZ  
 COUNTRY CODE ? [Quit] (Default KR, ZZ : for debug) : us
SYSMODE(WLAN MODE) ?
        1. Station
        2. Soft-AP
        3. WiFi Direct
        4. WiFi Direct P2P GO Fixed
        5. Station & Soft-AP
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MODE ?  [1/2/3/Quit] (Default Station) : 1
BAND ?
        1. 2.4 GHz
        2. 5 GHz
        3. AUTO
 BAND ?  [1/2/3/Quit] (Default 3. AUTO) : 1
[ STATION CONFIGURATION ]
============================================================================
[NO] [SSID]                                         [SIGNAL] [CH] [SECURITY]
----------------------------------------------------------------------------
[ 0] REL-GLOBAL_2.4G                                    -21   6     WPA2-ENT
[ 1] WiFi_Net_2.4G                                      -22   6     WPA2-ENT
[ 2] REL-GLOBAL                                         -22   6     WPA2-ENT
[ 3] WiFi_Public_2.4G                                   -23   6         WPA2
[ 4] RenesasMatter                                      -27  10         WPA2
----------------------------------------------------------------------------
[Enter] Rescan
============================================================================
Select SSID ? (1~5/M1~M5/Manual/Quit) : 4
 PSK-KEY(ASCII characters 8~63 or Hexadecimal characters 64) ? [Quit]
:********
 Do you want to set advanced WiFi configuration ? [No/Yes/Quit] (Default No) : n
Enable DPM (Dynamic Power Management) ? [Yes/No/Manual/Quit] : y
DPM factors : Defaults ? [Yes/No/Quit] : y
============================================
DPM MODE           : Enable
Keep Alive Time    : 30000 ms
User Wakeup Time   : 0 ms
TIM Wakeup Count   : 10 dtim
============================================
 DPM CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
============================================
BAND        : 2.4 GHz
SSID        : RenesasMatter
Security    : WPA2PSK
ENCRYPTION  : AES(CCMP)
Password    : 12345678
PMF         : Default
============================================
WIFI CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
IP Connection Type ? [Automatic IP/Static IP/Quit] : a
IP Connection Type: Automatic IP
 IP CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
 SNTP Client enable ? [Yes/No/Quit] : n
[/RA6W2-RRQ61051/dpm] # ble
[/RA6W2-RRQ61051/ble] # ble_hibernate_enable
[/RA6W2-RRQ61051/ble] # reboot
>>> Network Interface (wlan0) : DOW
[wpa_supplicant_event_disassoc] CTRL-EVENT-DISCONNECTED bssid=ce:15:31:6e:b9:41 reason=3 locally_
generated=1
[/RA6W2-RRQ61051/ble] # 
Rebooting...
U
Wakeup source is 0x4
        ******************************************************
        *              RA6W2-RRQ61051 SDK Information
        * ---------------------------------------------------
        *
        * - CHIP Name       : RA6W2-RRQ61051 (D3095B)
        * - SKU Type        : 0x20, Dual Band (2.4 + 5 GHz) WI-FI 6
        * - CPU Type        : Cortex-M33 (160MHz)
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        * - Kernel Version  : FreeRTOS V11.1.0
        * - SFLASH Type     : 8 MB (Renesas AT25SL)
        * - SDK Version     : V8.0.3.0.2
        * - F/W Version     : RA6W2-RRQ61051-7a0e352c5e-1
        * - Boot Index      : 0
        * - F/W Build Time  : Apr 14 2026 12:33:57
        *
        ******************************************************
System Mode : Station Only (0)
<<Please check MAC address.>>
Network init...<<Please check MAC address.>>
OK
>>> Renesas RA6W2-RRQ61051 wpa_supplicant 2.10 - Sep/2023
>>> MAC address (sta0) : ec:9f:0d:9f:ff:fe
>>> Start STA mode...
Connection COMPLETE to ce:15:31:6e:b9:41
>>> Network Interface (wlan0) : UP
         Assigned addr   : 192.168.137.86
               netmask   : 255.255.255.0
               gateway   : 192.168.137.1
         DHCP Server IP  : 192.168.137.1
         Lease Time      : 168h 00m 00s
         Renewal Time    : 140h 00m 00s
>>> Start DPM Power-Down !!!
 

When the RA6W2 is in DPM Sleep mode, user input is not accepted by the debug terminal. To re-enable the input, see 
Appendix A.4 Disable DPM Mode.

A.4 Disable DPM Mode
When RA6W2 enters DPM Sleep mode, the debug terminal does not accept the input because the UART interfaces 
are powered down. To exit this state and restart the setup process, complete the following steps:
 1. Copy the string pmgr add_constraint PMGR_CONSTRAINT_SLEEP_PROHIBITED to the clipboard.

For example, open Notepad, type pmgr add_constraint PMGR_CONSTRAINT_SLEEP_PROHIBITED, and then copy 
(Ctrl+C) the command string.

 2. To restart the EVK, use the RST_N button.
 3. After restarting, before the message >>> Start DPM Power-Down !!! appears on the console, paste the pmgr 

add_constraint PMGR_CONSTRAINT_SLEEP_PROHIBITED string in the terminal window, and press Enter.
When this procedure is done successfully, the UART console responds as normal. If DPM mode does not stop 
successfully, try the process again:

>>> Start DPM Power-Down !!!
 
Wakeup source is 0x4
 
        ******************************************************
        *              RA6W2-RRQ61051 SDK Information
        * ---------------------------------------------------
        *
        * - CHIP Name       : RA6W2-RRQ61051 (D3095B)
        * - SKU Type        : 0x20, Dual Band (2.4 + 5 GHz) WI-FI 6
        * - CPU Type        : Cortex-M33 (160MHz)
        * - Kernel Version  : FreeRTOS V11.1.0
        * - SFLASH Type     : 8 MB (Renesas AT25SL)
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        * - SDK Version     : V8.0.3.0.6
        * - F/W Version     : RA6W2-RRQ61051-9092f23dda-1
        * - FSP Version     : 2.0.1
        * - Boot Index      : 0
        *
        ******************************************************
 
 
System Mode : Station Only (0)
Network init...OK
>>> Renesas RA6W2-RRQ61051 wpa_supplicant 2.10 - Sep/2023
>>> MAC address (sta0) : 74:90:50:b0:09:fe
>>> Start STA mode...
pmgr add_constraint PMGR_CONSTRAINT_SLEEP_PROHIBITED          // pmgr command to disable DPM
 
[/RA6W2-RRQ61051/pmgr] #
Connection COMPLETE to 10:7c:61:9a:ca:58
         Assigned addr   : 192.168.50.163
               netmask   : 255.255.255.0
               gateway   : 192.168.50.1
         DHCP Server IP  : 192.168.50.1
         Lease Time      : 24h 00m 00s
         Renewal Time    : 20h 00m 00s

DPM can be restarted at any time with the pmgr remove_constraint PMGR_CONSTRAINT_SLEEP_PROHIBITED 
command.
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Appendix B AT Command Wi-Fi Provisioning
You can provision the Wi-Fi connection using AT commands through the AT command terminal. For AT command 
interface configuration, see Section Section 4.2.3 Configure RA6W2 EVK AT Command Interface. To provision a Wi-
Fi connection, complete the following steps:
 1. To see nearby apps, enable echo output and then initiate a Wi-Fi scan.

ATE
AT+WFSCAN

 2. Configure the desired Wi-Fi connection with the following command:
 l AT+WFJAP=<SSID>,<Security>,<Encryption>,<Passphrase>

 o <SSID>: AP SSID
 o <Security>: Security protocol.

0 (OPEN), 1 (WEP), 2 (WPA), 3 (WPA2), 4 (WPA+WPA2), 5 (WPA3 OWE), 6 (WPA3 SAE), 7 (WPA2 RSN 
and WPA3 SAE)

 o <Encryption>:
0 (TKIP), 1 (AES), 2 (TKIP+AES)

 o <Key>: Passphrase. 8 ~ 63 characters are allowed

Example:
If selecting Dlink_AP_24G_FZ, the configuration selected should be as follows:
 n <SSID>: Dlink_AP_24G_FZ
 n <Security>: 4 for WPA+WPA2 Security protocol.
 n <Encryption>: 2 for TKIP+AES encryption.
 n <Key>: 12345678 (password of AP).
The example of the command: AT+WFJAP=Dlink_AP_24G_FZ,4,2,12345678
The RA6W2 reboots and connects to the given SSID, with DPM enabled by default.
The procedure is similar for a 5 GHz connection. In this example, the only changes are to <Security> (changed to 
WPA3), and <Encryption> (changed to AES).
AT+WFJAP=R15-5G,6,1,12345678
The additional useful commands for Wi-Fi configuration:

AT+WFSTAT   // for getting the Wi-Fi configuration.
ATF    // for factory reset
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Appendix C Flash Using flash_img_downloader Script
Programming firmware images to the EVK requires the flash downloader. The flash downloader (flash_img_
downloader.zip) is provided with binary images (see Figure 110).

Figure 110. Flash downloader
System requirements:
 n OS (Windows 10 64 bit/Ubuntu 20.04 LTS 64 bit).
 n Python 3.12.x and pycryptodome package.
NOTE  
Install mandatory python library.
pycryptodome

 n For Windows
Open a Windows command prompt and enter the following commands:
python -m pip install pycryptodome

 n For Linux OS
Open a terminal window and enter the following commands:
python -m pip install pycryptodome

Check python version using python –version
Python 3.1.X

To program the firmware image through the UART, you have the following options:
 n For Windows, use flash_img_downloader_uart.bat batch file.
 n For Linux, use flash_img_downloader_uart.sh shell script file.
 n Hardware: RA6W2 EVK, see Figure 111.
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Figure 111. RA6W2 EVK hardware
 n This tool is for both Windows and Linux and the programming can be done automatically.
 n Software: Flash Downloader for UART.

C.1 Program Firmware Images for Windows
To program the firmware image using Windows:
 1. Execute the batch script in the Windows command prompt.

Usage: flash_img_downloader_uart.bat [img full path]
Example: flash_img_downloader_uart.bat <full_path>/wifi_ble_coex_ek_ra6w2_ep.img

Figure 112. Run flash downloader with UART
 2. Enter COM port to use (lowest numbered COM port).

NOTE  
Before running the flash downloader with UART, close any other instances of this COM port to make sure of COM port 
availability.

Figure 113. Enter COM port for UART
 3. If prompted, to start programming the firmware, press the RST_N (Reset) button on the RA6W2 EVK.
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Figure 114. Reset RA6W2 EVK
The script finishes programming the firmware image through UART.

Figure 115. Finished programming a firmware image with UART
 4. After firmware programming is completed, open the Terminal Emulator and configure Tera Term Serial Terminal 

Application for Windows, see Section 4.2 EK-RA6W2 Serial Debug Interface Configuration.
 5. Press the Reset button on the EVK.
 6. Check the booting status through UART.

Figure 116. Flash boot with downloaded image

C.2 Program Firmware Images for Linux
To program the firmware image using Linux:
 1. Execute the Shell script in the Terminal.

Usage: flash_img_downloader_uart.sh [img full path]
Example: flash_img_downloader_uart.sh <full_path>/wlan_ble_coex_ek_ra6w2_ep.img

Figure 117. Run flash downloader with UART
NOTE  
While programming, make sure the port of RA6W2 interface should be /dev/ttyUSB0. Also close any other minicom 
instances of this port to make sure of port availability.

 2. If prompted, to start programming the firmware, press the RST_N (Reset) button on the RA6W2 EVK.
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Figure 118. Reset RA6W2 EVK
The script finishes programming the firmware image through UART.

Figure 119. Finished programming a firmware image with UART
 3. After firmware programming completes, open the Terminal Emulator and configure.
 4. On the EVK, press the Reset button.
 5. Check the booting status through UART.

Figure 120. Flash boot with downloaded image
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Appendix D Python Integration in e2 studio Windows
If Python 3 is already installed and it is not showing in the e2 studio terminal, follow the steps:
 1. In Windows, go to Apps > Advanced app settings > App execution aliases > python3.exe.

Figure 121. Application execution aliases
 2. Create a python3.bat file with the following script.

@echo off
python %*

 3. Copy the python3.bat file to the already existing python3 installation location.
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Figure 122. Python3 Installation folder
 4. Restart e2 studio and check if Python 3 is properly integrated using the below command.

python3 --version
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Appendix E SFlash Memory Maps
This section describes the memory maps for the external SFlash device and how to change the SFlash device 
memory map used in the SDK.
NOTE
The RA6W2 SDK currently supports the following SFlash types:

 n 8-MB SFlash
To use a different type of SFlash with the RA6W2, contact Renesas Electronics to confirm compatibility.

The RA6W2 SDK supports 8-MB SFlash.
Table 5. 8-MB SFlash map for RA6W2
Address Name Description Size (kB)
0x0000_0000 Product Header  4

0x0000_1000 Product Header - Backup  4

0x0000_2000 RTOS #0 (64*1024 * 40) 2560

0x0028_2000 Reserved RTOS binary size – Expandable area 508

0x0030_0000 NVRAM NVRAM VEE Segment #1 40

0x0030_A000 NVRAM Backup (Multiplier 8) 280

0x0035_0000 TLS_Cert_Base  704

0x0035_0000 TLS Certificate WPA_Enterprise CA 4 

0x0035_1000 Cert 4 

0x0035_2000 Private key 4 

0x0035_3000 Diffie-Hellmann key 4 

0x0035_4000 TLS Certificate OTA_Update CA 4 

0x0035_5000 Cert 4 

0x0035_6000 Private key 4 

0x0035_7000 Diffie-Hellmann key 4 

0x0035_8000 TLS Certificate HTTPs Client Cert 4 

0x0035_9000 Private key 4 

0x0035_A000 Diffie-Hellmann key 4 

0x0035_B000 CA 4 

0x0035_C000 TLS Certificate HTTPs Server Cert 4 

0x0035_D000 Private key 4 

0x0035_E000 Diffie-Hellmann key 4 

0x0035_F000 Cert 4 

0x0036_0000 TLS Certificate MQTTs Client Cert 4 

0x0036_1000 Private key 4 

0x0036_2000 Diffie-Hellmann key 4 

0x0036_3000 CA 4 

0x0036_4000 TLS Certificate AT-CMD #0 ~ #15 AT command TLS Certificate Key #0 ~ #15 64

0x0037_4000 TLS Certificate AWS  20 or Unused

0x0037_9000 TLS Certificate Matter  20 or Unused

0x0037_E000 TLS Certificate MISC1  20 or Unused

0x0038_3000 TLS Certificate MISC2  20 or Unused

0x0038_8000 TLS Certificate MISC3  20 or Unused
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Address Name Description Size (kB)
0x0038_D000 TLS Certificate MISC4  20 or Unused

0x0039_2000 TLS Certificate MISC5  20 or Unused

0x0039_7000 TLS Certificate MISC6  20 or Unused

0x0039_C000 TLS Certificate MISC7  20 or Unused

0x003A_1000 TLS Certificate MISC8  20 or Unused

0x003F_E000 Secure Asset Product Area  4 or Unused

0x0040_0000 RTOS #1 (64*1024 * 40) 2560

0x0068_0000 Reserved RTOS binary size – Expandable area 512

0x0070_0000 Bluetooth LE Firmware DA14531 Bluetooth LE firmware area 128

0x0072_0000 User Area  892

0x007F_F000 Partition Table  4
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8.    Revision History
Revision Date Description
1.04 May 7, 2026 Updated the version of e2studio to 2015-12

Updated the FSP version to RAFW FSP 2.0.1
Updated SFlash Memory Map

1.03 Nov 28, 2025 Updated to Rev E EVK. Updated sections about EVK and its setup, test procedures, SDK and 
build setup. Added appendix about Python integration.

1.02 Aug 31, 2025 Added and updated setting up EK-RA6W2, test procedures, SDK and build setup, and using 
flash_img_downloader script.

1.01 May 30, 2025  n Added and updated sections about configuring RA6W2 EVB AT Command Interface, 
measuring Current Consumption for Sleep 1, and Sample Projects.

 n Changed the chip name from RRQ61400 to RA6W2.

1.00 Mar 13, 2025 First release.

RoHS Compliance

Renesas Electronics’ suppliers certify that its products are in compliance with the requirements of Directive 
2011/65/EU of the European Parliament on the restriction of the use of certain hazardous substances in electrical and 
electronic equipment. RoHS certificates from our suppliers are available on request.
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IMPORTANT NOTICE AND DISCLAIMER
RENESAS ELECTRONICS CORPORATION AND ITS SUBSIDIARIES (“RENESAS”) PROVIDES TECHNICAL 
SPECIFICATIONS AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE 
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES 
“AS IS” AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT OF THIRD-PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for developers who are designing with Renesas products. You are solely responsible for (1) selecting 
the appropriate products for your application, (2) designing, validating, and testing your application, and (3) ensuring your 
application meets applicable standards, and any other safety, security, or other requirements. These resources are subject to 
change without notice. Renesas grants you permission to use these resources only to develop an application that uses Renesas 
products. Other reproduction or use of these resources is strictly prohibited. No license is granted to any other Renesas intellectual 
property or to any third-party intellectual property. Renesas disclaims responsibility for, and you will fully indemnify Renesas and its 
representatives against, any claims, damages, costs, losses, or liabilities arising from your use of these resources. Renesas' 
products are provided only subject to Renesas' Terms and Conditions of Sale or other applicable terms agreed to in writing. No use 
of any Renesas resources expands or otherwise alters any applicable warranties or warranty disclaimers for these products.

 

 
(Disclaimer Rev.1.01)
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Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Contact Information

For further information on a product, technology, the most up-
to-date version of a document, or your nearest sales office, 
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Trademarks
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